Excel Pivot Tables: Design a Pivot Table & Get the Report You Want

SESSION HANDOUT
Prepared for Applied Client Network

Applied Client Network
2340 S. River Road, Suite 311
Des Plaines, IL 60018
Phone: 220-220-1444 Fax: 224-220-1443

Target Audience:
- Accounting
- Non-Insurance Accounting
- Administrative
- Principal
- General
- Human Resources
- Account Executive
- Customer Service Representative
- New Producer
- Experienced Producer
- IT
- Other: Operations, Trainer

Seminar Type: Microsoft Products, Reports
Seminar Level: Intermediate Level: An Intermediate level class takes the concepts originated from a basic level course, and adds more layers or parallel concepts. For functional courses, these classes will require the participant or attendee to have some basis to work from as they are learning new facets of the agency management system or software program.

Class Description: Discover the Power of the Pivot! Summarize and Analyze your data quickly and easily, and have fun while you're at it. These skills will save you hours of time you would normally use formatting and calculating. Automatically sort, sum, count, and layout the information you want to see. Don't just watch, do it yourself! Follow along with the Excel workbook provided to practice the skills demonstrated.

Learning Outcomes:
- Format the Excel data for a Pivot Table
SESSION HANDOUT
Excel Pivot Tables

- Take data from your Management Systems into Excel and manipulate it into meaningful information.
- See how easy it is to Drag and Drop data into Columns, Rows, Values and Filters to build tables and reflect different views of the same data that will make you a report rock star in your agency.

Assumptions: This seminar is based on the following
This seminar is based on the following
TAM Version 2014
Microsoft ® Word Version 2010

Table of Contents

Overview ................................................................................................................................. 4
Setup the data in Excel........................................................................................................ 4
Create a Pivot Table............................................................................................................ 4
Change Field Settings ....................................................................................................... 5
Sort Data in Pivot Table .................................................................................................... 6
See the Detail for a Data Value ........................................................................................ 6
Place subtotals at bottom of Categories ......................................................................... 7
Group Data (ie, group dates by month/year) ................................................................. 8
Copy and Paste Data only to a new sheet ...................................................................... 8
Slicers ................................................................................................................................. 9
APPENDIX I .................................................................................................................. 11
Sample Search-Customers, Policies Current Criteria/Fields ........................................ 11
Overview
Using a pivot table is the quickest way to summarize and compare data.

So instead of running multiple iterations of the same report from my management system, I just run a single report exported to Excel, and use the power of pivot tables to analyze the data in multiple ways.

Setup the data in Excel
Here are a few rules to follow when setting up your data so pivot tables play nicely:

- You need to have your data organized in columns with headings. These headings will be used when you create the pivot table. Excel will display an error if a heading is missing on a column with data.
- Make sure there are no empty columns or rows in your data. Empty cells are OK, but not empty rows or columns.
- Consistent data in all cells. If you have a date column, make sure all the values in that column are dates (or blank). If you have a quantity column, make sure all the values are numbers (or blank) and not words.

Create a Pivot Table
To create a Pivot Table, click on any cell in the worksheet.

On the Insert tab, Tables group, click the Pivot Table button.

Just click OK to accept the defaults. Excel will insert a new worksheet with the layout area and the Pivot Table Field List.
If you get an error that the PivotTable field name is not valid, it’s because there is a column in your original spreadsheet that does not have a header. Since the Headers appear in the Pivot Table field list, you MUST have a header for each column.

The Pivot Table Field List contains ALL the columns from the source data worksheet.

There are several ways to move fields to the areas of the pivot table:

1. Right Click on the field name, and select the desired area.
2. Drag and Drop the variables of your choice to the Row, Column, Value and Filter boxes. You can easily move these variables from one box to another. Just drag and drop and watch your Pivot Table change.
3. Check the box next to the Field Name. Excel will decide where to put the data (Drag and Drop to another box if you don’t like where Excel put it).

NOTE: If the Pivot Table Field List disappears, just click on any cell in the Pivot Table, and the Field List will appear again.

Example: Insert a Pivot Table from the worksheet named “BOB12-13-2012”. List the Commission Amounts sorted by Policy Type.

Change Field Settings
- Right click on a data item in your pivot table and select Value Field Settings.
Excel Pivot Tables

• Select from options such as Sum, Average, Count, etc.
• Click Number Format and choose the format for your output.
• In the Custom Name field retype the heading so it is of more value to those who receive your report.

Example: I also want to see the number of policies per policy type. Drag and drop the co_amt field from the list to the Value Box. Right click on a number in the new column, and select “Value Field Settings”, and change from “Sum” to “Count”.

Sort Data in Pivot Table
• Click on any cell in the column of the Pivot Table to sort
• On the Pivot Table Tools tab, in the Sort Group, Select A-Z or Z-A, and the Pivot Table will be sorted accordingly.

See the Detail for a Data Value
• Double Click on any data value in the Pivot Table, and Excel will open a new worksheet in the existing workbook with a table containing all the rows of detail that total the number in the Pivot Table.
• If you no longer need the detail sheet, just right click on the sheet name, and Click Delete.
Example: Let’s add columns for each department by dragging and dropping the Department Code (Pol_dept) field to the Column Labels.

Example: Now, let’s add a Filter for the Billing Company E50. Drag and Drop Billing Company (Bco) to the Report Filter. Click the dropdown arrow next to the word ALL, and select company E50.

Example: Now, let’s add another piece of data to our table. Let’s bring the Producer into the row above the policy type. Drag and drop the Pr1 field into the “Row Label” box. Notice the Producer code is below the Policy Type. Just Drag and Drop the Pr1 field above the Pol_type field. Now the pivot table is sorted by Producer, by Policy Type.

Place subtotals at bottom of Categories
Example: I’d like to see my totals below the category, not above it. To change how the table is subtotaling:

- Make sure your cursor is clicked somewhere in the Pivot Table.

- Click on the **Design** tab on the PivotTable Tools ribbon.
- On the left-hand side of the ribbon, click on the Subtotals button.
- Click on Show all Subtotals at Bottom of Group.
Group Data (ie, group dates by month/year)

- Right click on a date in the pivot table.
- Select Group
- In the Grouping dialog box, select Month and Year, or just Year

Example: Insert a Pivot Table from the worksheet named “Prod Data 2011-2012”. List the Commission Amounts sorted by Producer, by Year

Copy and Paste Data only to a new sheet

- Click in the first cell in the Pivot Table
- Ctrl-A on your keyboard (this will select the active cells)
- Click Copy

- Click in the new worksheet.
- Click Paste-Paste Values

This will paste only the data, not the pivot table to the new worksheet.
Slicers

In earlier versions of Microsoft Excel, you can use report filters to filter data in a PivotTable report, but it is not easy to see the current filtering state when you filter on multiple items. In Microsoft Excel 2010, you have the option to use slicers to filter the data. Slicers provide buttons that you can click to filter PivotTable data. In addition to quick filtering, slicers also indicate the current filtering state, which makes it easy to understand what exactly is shown in a filtered PivotTable report.

A slicer typically displays the following elements:

1. A slicer header indicates the category of the items in the slicer.
2. A filtering button that is not selected indicates that the item is not included in the filter.
3. A filtering button that is selected indicates that the item is included in the filter.
4. A Clear Filter button removes the filter by selecting all items in the slicer.
5. A scroll bar enables scrolling when there are more items than are currently visible in the slicer.
6. Border moving and resizing controls allow you to change the size and location of the slicer.

Create a Slicer
1. Click anywhere in the PivotTable report for which you want to create a slicer.

   This displays the PivotTable Tools, adding an Options and a Design tab.

2. On the Options tab, in the Sort & Filter group, click Insert Slicer.
3. In the Insert Slicers dialog box, select the check box of the PivotTable fields for which you want to create a slicer.

4. Click OK. A slicer is displayed for every field that you selected.

5. In each slicer, click the items on which you want to filter.

6. To select more than one item, hold down CTRL, and then click the items on which you want to filter.

**Delete a Slicer**

- Click the slicer, and then press DELETE.
Sample Search-Customers, Policies Current Criteria/Fields

1. Click Reports – Search
2. Report Type: Search – Customers
4. Criteria Tab

   - **Policy Status** – Only ACTIVE policy statuses (NEW, REN, REI, REW – whichever codes YOUR agency uses)

Select Active Policy Statuses
Select Range of dates that does NOT include expired policies
Will list ALL billing screens, including subsections
b. **Expiration Date** – You might want to limit the Expiration Date range to include only billing screens that are expiring after the month you are closing. For example, if you are running the report at November 30, 2009, choose an Expiration Date range of 12/01/09 thru 11/30/2015. This will keep all the old billing screens with inaccurate policy statuses from skewing the report, but include all expiration dates in the next six years.

c. **Record Listings** – Choose “List Each Time Found”, and then manipulate in Excel to get only the commission and premium on the main package or on the subsections.

5. **FIELDS/SORT** (Include as many as desired, but be consistent each month)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Excel Column Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer/Pol_idx Number</td>
<td>Pol_polidx</td>
</tr>
<tr>
<td>Agency</td>
<td>Pol_agcy</td>
</tr>
<tr>
<td>Branch</td>
<td>Pol_brch</td>
</tr>
<tr>
<td>Department</td>
<td>Pol_dept</td>
</tr>
<tr>
<td>Policy Number</td>
<td>Pol</td>
</tr>
<tr>
<td>Policy Effective Date</td>
<td>Effective</td>
</tr>
<tr>
<td>Policy Expiration Date</td>
<td>Expires</td>
</tr>
<tr>
<td>Date First Written</td>
<td>Fwritten</td>
</tr>
<tr>
<td>Policy Type</td>
<td>Pol_type</td>
</tr>
<tr>
<td>Policy Type Group</td>
<td>Typegroup</td>
</tr>
<tr>
<td>Issuing Company</td>
<td>Ico</td>
</tr>
<tr>
<td>Billing Company</td>
<td>Bco</td>
</tr>
<tr>
<td>Type of Agency Commission</td>
<td>Co_type</td>
</tr>
<tr>
<td>Total Commission Amount</td>
<td>Co_amt</td>
</tr>
<tr>
<td>Total Commission %</td>
<td>Com_p</td>
</tr>
<tr>
<td>Billing Mode</td>
<td>Bill</td>
</tr>
<tr>
<td>Producer One</td>
<td>Pr1</td>
</tr>
<tr>
<td>Producer One Comm %</td>
<td>Pr_p</td>
</tr>
<tr>
<td>Producer One Comm $</td>
<td>Pr_amt1</td>
</tr>
<tr>
<td>Producer Two</td>
<td>Pr2</td>
</tr>
<tr>
<td>Producer Two Comm %</td>
<td>Pr_p2</td>
</tr>
<tr>
<td>Producer Two Comm $</td>
<td>Pr_amt2</td>
</tr>
<tr>
<td>Producer Three</td>
<td>Pr3</td>
</tr>
<tr>
<td>Producer Three Comm %</td>
<td>Pr_p3</td>
</tr>
<tr>
<td>Producer Three Comm $</td>
<td>Pr_amt3</td>
</tr>
<tr>
<td>Policy Premium</td>
<td>Prem</td>
</tr>
<tr>
<td>Policy Status</td>
<td>Pol_status</td>
</tr>
<tr>
<td>Policy Customer Service Rep</td>
<td>Pol_csr</td>
</tr>
<tr>
<td>Customer Number</td>
<td>Cust_rec</td>
</tr>
<tr>
<td>Customer Name</td>
<td>Cust_name</td>
</tr>
</tbody>
</table>
6. Back to Report Selection Tab:
   a. **Output Destination** – *Excel-Raw Data*

7. Click **Run**.

8. Always choose the 3rd radio button to “Send output to a temporary file”. Click **OK**.

9. Click “**Yes**” to create a new temporary file.

- Click “**Yes**” to Load Excel. Excel will open with your Billing Screen data.